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A personal view from Bob

! Adobe Photoshop CS3 
! Standard and Extended

dobe Photoshop is the undisputed king of image 
editors and one you’ll want if you’re a serious 

photographer or graphic artist. Photoshop CS3, the 
most popular application in Adobe’s Creative 
Suite (CS3), is compatible with Leopard and 
optimized to run much faster on Intel Macs. 
It’s designed to let you work more effec-
tively. I’ve used Photoshop 7 for a long time 
and CS3 is a major upgrade with many new 
features and enhancements. I can only touch 
here on a few that I’m particularly excited 
about. I was immediately struck by the 
streamlined interface and lack of toolbar and 
palette clutter. The toolbar can be a single 
column and the palettes collapsed to just 
icons (or icons with names), as shown right, 
to maximize working space. Palettes reside in 
docks that you can quickly show or hide. 
Click any palette to expand or collapse it. 

Bridge: Photoshop comes with Adobe Bridge, 
successor to the file browser in earlier versions. 
It provides a bridge between your images and 
CS3 applications. It’s where you’ll be working much 
of the time. Although reminiscent of iPhoto, it’s much 
more powerful. It organizes and manages digital assets, 
(including Illustrator, InDesign, Camera Raw and 
video files) and lets you edit hidden metadata in the 
files. Bridge can import from your camera, letting you 
rename and relabel the photos. It also opens JPEG and 
TIFF images as Camera Raw for nondestructive edit-
ing, with some limitations.

Camera Raw: High-end digital cameras export RAW 
images (digital negatives) that are minimally processed 

(or compromised) by the camera, allowing precise ad-
justments in Photoshop before being converted to an 
RGB file such as TIFF or JPEG. You have complete 
control. Photoshop CS3 comes with the Camera Raw 
plug-in that lets you edit images nondestructively. 

Nondestructive Smart Filters: This command lets 
you modify and save any image without changing the 
underlying pixels. You can return later to revert to the 
original or re-edit.

Quick Select: Selecting parts of an image for editing 
or masking has always been a challenging task and 
Photoshop has a number of tools to facilitate it. The 
Quick Selection tool is new. Drag to select a part of the 
image based on a range of colors and educate the brush 
to reject colors you don’t want selected. 

Refine Edge is a new filter that lets you fine-tune a 
selection. You can see the effects of feathering and 
other edge effects. 

Curves dialog has changed and now displays a histo-
gram, like the levels dialog.

Photomerge: Stitching together a set of panoramic 
photos is greatly improved to compensate for lens dis-
tortion and lighting changes between photos.

With it’s enormous power, learning to use Photoshop 
can be daunting. Fortunately there are many helpful 
training aids and on-line video tutorials, but plan on 
spending time to learn it.

Photoshop CS3 now comes in Standard $649) and Ex-
tended ($999) versions (discounts, academic and up-
grades are available). The extended version adds 3D 
and motion support along with image analysis and 
supports MATLAB and DICOM (medical images). 
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Welcome to
South Bay Apple Mac User Group

You and your friends are invited to attend our next meeting.
Our membership dues are only $35 per year, entitling you 
to this newsletter each month and many more benefits.
If you would like to become a member or get more info on 
SBAMUG, feel free to check out our web site at:   
www.sbamug.com

Meetings are held at the
Redondo Beach Community Center

320 Knob Hill, Redondo Beach
(see map & directions on page 11)

Officers & Volunteers:
President:................LJ Palmer

Vice President:...........Jim Pernal

Secretary:................Wayne Inman

Treasurer:................CW Mitchell

Directors at Large:.......Dave Nathanson,

George Kiefer, Dorothy Weeks, Louise Polsky,

Chuck Mulvey, Jayne Palmer

Membership Director:......CW Mitchell

WebMaster & User Group Ambassador:

..........................Bob Brooks

Server Director:..........Dave Nathanson

USPS Liaison:.............Don Myers

PD Disk Editor:...........Jim Pernal

Program Director:.........George Kiefer

Newsletter Editor:........Dorothy Weeks

Raffle Chairman:..........George Griffiths

Raffle Director:..........Chuck Mulvey

RefreshmentCoordinator:.Louise Polsky, Taffy Rath

Membership Report:
(You may notice your name is in larger letters 

on your card. That is so it can be used as a 

name tag at the meetings.

Your Membership Cards are in the mail!) 

Current Membership - 159

Welcome New Members -

Fran Pullara

Thank You Member Renewals - 

Kazuo Ogawa, Marie Cooper, Janet Johnson, 

James Vaccaro, Grace Scott, Arivid von 

Nordenflycht, Joan Beth King.

Remember, if your name is not spelled right or 

your expiration date is wrong, contact 

cwmitchell@sbamug.com for correction.

                

                                         MONTHLY CALENDAR
1st Sat - SBAMUG Core Group Mtg @ announced locations, 10 am

   1st Thur - LB Mug @ Emerson School,  Palo Verde & Willow, Long Beach, 7 pm
1st Sat - Orange Apple UG, Orange Coast College, Chem Bldg, Costa Mesa, 8am-1pm
3rd Sat - Adobe Tech Exchange Toyota Bldg on Grammercy near 190th, 9 am; $10
Last Wed - SBAMUG Monthly Meeting
Last Tues - WOCMUG @ Emerson School,  Palo Verde & Willow, Long Beach, 7 pm
Last Sat - TRW / Northrop Ham Radio & Computer Swap Meet, 7 am - 11:30 am

The SOUTH BAY MUG (ISSN 1058-7810) is published monthly for $35.00 per year by South Bay Apple Mac User Group,
2550 Via Tejon, Suite 3J, Palos Verdes Estates, CA 90274. Periodicals Postage Paid at Palos Verdes Peninsula, CA and at additional 
mailing offices. POSTMASTER: Send address changes to THE SOUTH BAY MUG, P.O. Box 432, Redondo Beach, CA 90277-0432.

The South Bay MUG is published by the South Bay Apple Mac User Group (non-profit).  Excerpts may be reprinted by user groups and 
other non-profit media. Credit must be given to SBAMUG and the author. In addition, a copy of all reprinted materials must be sent to us 
at the address listed above. The South Bay MUG is an independent publication not affiliated or otherwise associated with or sponsored 

or sanctioned by Apple® Computer, Inc. The opinions, statements, positions and views stated herein are those of the author(s) or 
publisher and are not intended to be the opinions, statements, positions or views of Apple® Computer, Inc.

Members are invited and encouraged to submit articles and original artwork for publication. Newsletter 

deadline is the last Wednesday of the month. Articles may be edited to fit in available space. 

Please send to: dhweeks@sbamug.com 

P. O. Box 432
Redondo Beach, CA
                90277-0432

310-644-3315
Email: info@sbamug.com



SBAMUG January 2008 PD CD

appy New Year to all.  Nine programs this

month.

Bookdog_5.0.7.dmg Manage and sort bookmarks

for the popular web browsers. Supports the new (and

final) Netscape 9.  10.3.9-10.5

DrawBerry 0.4.zip Simple vector drawing program.

Freeware. Has a grid and you can elect  to snap to it

or not. Lines, curved lines, arrows, circles,

rectangles, that's about it.  Requires OSX 10.4 -10.5.

FileJuicer-4.9.2.dmg Extract images, audio, and

text from within files.  10.3.9 to 10.5

iCab400_UB_OSX.zip- iCab was one of the

alternate Web browsers available for the Mac. Many

felt the previous version was “long in the tooth” so

to say. Well, this is a new version as well as a

universal binary so it will run native on Intel Macs

as well as on PPC Macs.  10.3.9 to 10.5.

G3/G4/G5/Intel.  Has bookmarks, download

manger, Java/Javascript support. Tried it on the

complex CNN page, and it worked well, including

the videos.  I guess we can get Bob to run this one

through its paces, and report on it.

LittleSnitch_2.0.1.dmg - Informs you when a

program tries to establish an internet connection

going out. You can select to let it run once, until you

quit, or forever.  Now most all programs that do this

are merely trying to check for updates.  However if

there is a bad program on your Mac,  or you are

concerned about privacy, this program may make

sense.  OS 10.4/10.5.

MacGourmet-2.2.4.dmg- Latest update to this

recipe program. OSX 10.4/10.5 Intel and PPC

Nutrition-1.1.dmg A “add-in” program for

MacGourmet.  Provides nutritional information for

the recipes. Requires version 2.2 of MacGourmet, so

you know why I included the updated program

above. Same requirements for the OS.

PrimeNumberGenerator.zip Freeware, OSX 10.2

to 10.5. Generates a list of prime numbers.  Choose

to start at a given number, or generate a list between

two numbers.

SteamTRAIN 3.dmg.bin-  Steam Train simulator.

Switch tracks. Plenty of controls,  sand for traction

and the like. You will need to switch tracks. Simple

scenery. 10.3 is the minimum requirement.

CD for this month will be at the February 2008

meeting as the January-February 2008 CD.

 Catch you at the January meeting.

Jim Pernal, PD Editor

Summarize Your Stories

When laying out a long story in a newsletter or

magazine, it’s often helpful to summarize a story, or

a section of a story in a pull-quote or abstract. But

how to find the best quote when you’re on a deadline

and need it fast? Fortunately, Mac OS X offers a

great tool that almost no one knows about: Summary

Service.

To find this utility, select some text in Adobe

InDesign or some other program that supports this

Mac OS X Service (such as TextEdit) and choose

Summarize from Services under the Application

menu. You can adjust how long you want your

summary (in number of sentences or paragraphs) in

the Summary dialog box. Drag the Summary Size

slider to the left to get a more focused summary; for

a pull-quote a one- or two-sentence summary is best.

You wouldn’t expect a computer to be able to

analyze some text and provide a good summary but

Summary Service is surprisingly good. Try it!

Drag the Summary slider to the left to get a more

condensed version of your selected text.

Courtesy of Apple.com
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Intuit Alienates Mac Users With
QuickBooks Fiasco

by Rich Mogull, Courtesy of TidBits,
Jan.04 2008

n 04-Jan-08, Intuit released a patch for
QuickBooks Pro for Mac 2006 to resolve a

widely reported problem where all files on a
user's Desktop, including subdirectories, could
be permanently deleted if automatic updates
were enabled. Instructions for manually updating
QuickBooks are available from Intuit. All
QuickBooks users should immediately apply this
patch, even if you manually disabled automatic
updates.

The QuickBooks Fiasco -- Several weeks ago,
just as we (and many others) were starting to
wrap up for the holidays, some users of
QuickBooks Pro for Mac 2006 experienced
failed automatic updates that deleted the Desktop
folder and its contents. The update would fail
partway through the process, alerting the user
that "There is not enough space to install." The
updater would then delete the Desktop folder.
The files were permanently deleted, not moved
to the Trash. Only QuickBooks 2006 users lost
any data; QuickBooks 2007 users merely had
extraneous folders placed in their user directory
when the update failed. Intuit issued an initial
patch on 18-Dec-07, but it was still possible to
download the bad patch accidentally under
certain circumstances. The new patch (version
R5) disables the automatic update mechanism.

More information is available from Macworld
and the QuickBooks user forum, which is filled
with hundreds of angry QuickBooks users.

Intuit reportedly responded slowly to the
problem at first, but later sent an email message
to at least some affected users offering assistance
in recovering files using Prosoft's $99 Data
Rescue II. Users near an Apple Store were
directed to the Genius Bar for help, and those
who couldn't visit an Apple Store were provided
with instructions for using Data Rescue II, with
both groups being reimbursed for the software.
(If you're still dealing with this situation, contact

Intuit at machelp@intuit.com.)

Unfortunately, data recovery isn't always easy or
even possible after file deletion, depending
largely on whether the computer was used after
the deletion happened. In some situations, users
have been forced to resort to professional data
recovery services such as DriveSavers that can
cost hundreds or even thousands of dollars.
Intuit's public statements haven't discussed
whether or not the company will reimburse users
for such expenses; they merely say, "If you have
already performed a data recovery activity before
this email was sent, please inform us at
machelp@intuit.com so that we can work with
you on a one-on-one basis."

As always, remember that the best protection
against unexpected data loss is not data recovery
software, but regular backups. There's a reason
why Joe Kissell's "Take Control of Mac OS X
Backups" and "Take Control of Easy Backups in
Leopard" ebooks are so popular.

Should Mac Users Support Intuit? Intuit has
had a tumultuous relationship with the
Macintosh community ever since dropping, then
reviving, support for Macs in 1998 (see "Intuit
Drops Quicken for Macintosh", 1998-04-20).
QuickBooks Pro for Mac 2007 lacks many
features of its Windows-based cousin, including
critical features like credit card processing
support. While Intuit offers an online-only
version of the product (QuickBooks Online
Edition), it too runs only with current versions of
Internet Explorer on Windows.

While software updates that introduce additional
bugs are more common than we'd all like,
issuing an update that permanently deletes
unrelated user data is absolutely inexcusable. It's
mind-boggling that this update passed through
Intuit's quality assurance process.

Speaking as a small business owner who runs his
business on Macs, I have yet to find an
accounting solution I'm satisfied with. When I
started my business in August 2007, I enrolled
with QuickBooks Online Edition, which I access
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by running Windows in Parallels Desktop. It
initially appeared to meet my accounting and
payroll needs, but I recently ran into an obstacle
that's forcing me to look at other options.
QuickBooks Online Edition does not support any
type of file import - not even Intuit's own widely
used data exchange formats. Since my corporate
credit card isn't supported by a direct online link
within QuickBooks, I must manually enter all
transactions even though my credit card provider
offers QuickBooks-compatible downloads.

Since I'd rather spend my time writing TidBITS
articles than hand-entering receipts for every
snack I pick up at the airport, I started the
process to export my data out of QuickBooks
Online Edition and into a desktop version of
QuickBooks. The limitations of the Mac version
gave me pause, and I was about to purchase the
Windows version when this update problem
became public.

Being a firm believer of putting my money
where my mouth is, I've reconsidered supporting
any Intuit product and am downloading an
evaluation version of MYOB FirstEdge. [For
what it's worth, we've long used MYOB
AccountEdge for the TidBITS business
accounting. -Adam] I'm open-minded, and may
consider returning to Intuit in the future if they
improve the quality and reliability of their Mac
products, but for now it's time to explore options
from companies that treat their Mac users better.

Unless otherwise noted, this article is copyright

© 2008 Rich Mogull

TidBITS is copyright © 2008 TidBITS Publishing

Inc.

Editor’s tip:

Members of the SBAMUG who have been

subscribed to our email group, known as the

eGroup, got a very timely heads-up on this news

item. Be sure to take advantage of this great

benefit of SBAMUG membership by signing up

for the eGroup!

Mac 911
by Christopher Breen

Hiding iWeb pages
Q: Every time I make a page in iWeb, a link to it
appears in the navigation bar at the top of every
page. I'd like to make some pages accessible
only through links that I put on particular pages
in the site. Is this possible?-- Amal Chandaria

A: If you know where to look, it's easy to do this
in Apple's iWeb '08 (part of the $79 iLife suite)
or the original iWeb. Select the page you want to
hide in iWeb's Source list, choose View: Show
Inspector, click on the Page tab in the resulting
Inspector window, and deselect the Include Page
In Navigation Menu option (see "Control iWeb
Pages"). The link to that page (or set of pages, if
you've added a template such as Blog) will
disappear completely from the site's navigation
bar.

 Copying Keychains
Q: I have a lot of passwords stored in my
PowerBook's keychain. I want to put an exact
copy of the keychain on my iBook, just in case
my trusty PowerBook gives up the ghost, but
Mac Help is vague about how to do  this. --
Jason M. Krellenstein

A: The first step to copying your keychain is
finding it. Look inside your user folder
/Library/Keychains. Login.keychain is the
default user keychain file that OS X creates--the
one you unlock with your login password. (If
you've created a new keychain--Chris's
keychain.keychain, for example--you'll find it
here as well.)



Copying a keychain from one computer to
another, however, can be problematic. If that
other computer uses a different user name or
password, it'll bombard you with password
requests. Even with the same user name and
password, you'll run into the occasional request
for a password you know is in the keychain. For
example, when I copied my keychain to another
computer that used the same user name and
password, Internet Connect asked me for my
virtual private network (VPN)  password--
despite the fact that it never did that on the
original computer.

If you subscribe to Apple's .Mac service ($99 per
year), you'll be happy to know you already have
a way to avoid these problems. The service gives
you the option to sync your keychain between
your .Mac account and any Macs you sync with
it (see "Keychain Syncing").

You'll find the option for syncing keychains--as
well as bookmarks; calendars; contacts; Mail
accounts; and Mail rules, signatures, and smart
mailboxes--in the Sync tab of the .Mac
preference pane. Select the Synchronize With
.Mac option and then choose from the list.

Easy blind carbon copy option for Mail
Q: I like to use the Addresses window in Apple's
Mail to address my messages. But I don't see a
button there that will let me put an address in the
BCC field instead of the To field. What's the best
way to do that? -- Marty Grauer

A: The Addresses window (Window: Address
Panel) in Apple's Mail for OS  X 10.4 (Tiger)
doesn't include a BCC option. Try a different
approach: create a new e-mail message (1-N),
choose View: BCC Address Field (1- option-B),
open the Address Panel, and then drag the
recipient names you want into the BCC field.

Safari's regrettable memory
Q: Safari does a reasonable job of trying to guess
and fill in the Web address I am about to type.
After a while, though, its memory becomes
cluttered. When I type:

g

to go to Google, for example, it guesses that I
want to go to a genealogical Web page I visited
once. How can I erase all the Web addresses, or
at least the undesired ones, from Safari's brain?--
Bill  Zagotta

A: Apple's Safari 2.0.X doesn't provide one
single command for getting rid of these
memorized entries. They're concocted from
Safari's bookmarks, cache, and history. You can
get close by choosing Safari: Reset Safari, but
doing this can be problematic. In the first place,
it doesn't touch your bookmarks, so some of
those entries will still appear. Secondly, it will
clear more data than you probably want it to. In
addition to deleting the history and emptying the
cache, it clears the Downloads window, removes
all cookies, and gets rid of any user names and
passwords you may have asked it to save. As a
result, you might prefer to clear out Safari's
memory piecemeal instead. Start by choosing
Safari: Empty Cache. Then choose History:
Clear History. Then go into the Bookmarks area
and clear out bookmarks you don't want.

Alternatively, adopt some new habits. The first
would be to type more than just that first letter:

g

when you want to hop to Google.com. Try:

go

and see if that works. Or bypass the whole
autofill thing by clicking on the Address field,
pressing the spacebar once, and starting to type.
Autofill doesn't work if the first character is a
space.

 [Senior Editor Christopher Breen is the author

of The iPhone Pocket Guide (2nd Edition)  and

The iPod & iTunes Pocket Guide (3rd Edition).

Find Chris' books at  www.amazon.com and

www.peachpit.com. Get special user group

pricing on Macworld Magazine! Subscribe today

at http:// www.macworld.com/useroffer.]



Three Handy Tips
for iPhoto Organization

by Tonya Engst, Tidbits

rganizing my photos in iPhoto always
seems like a good idea, but my efforts often

fall short of my ideals. However, I've recently
been playing around in the new iPhoto 7 that
comes with iLife '08, and I've learned three
useful photo-organizing tips that are either new
in this version or that had previously eluded me.
I can't promise that these tips will help you whip
out your holiday cards from iPhoto while you
bake cookies and realize that Chanukah is way
before Christmas this year, but they certainly
won't hurt.

Rate Photos with Keyboard Shortcuts -- You
can rate a selected photo, in nearly any view,
including a slideshow, from the keyboard.
Command-5 rates your photo as 5 stars,
Command-4 as 4 stars, and so forth, down to
Command-0 (zero), which removes all stars.
Once photos are rated, you can then, for instance,
set up a smart album to find photos that have
more than a certain number of stars, making it
easy to view only your favorites.

Describe Photos in Batches -- Titling,
describing, and keywording photos goes faster if
you do it in batches. To do this, select a bunch of
photos and then choose Photos > Batch Change.
From the Batch Change dialog, you can change
the title or description of all the selected photos
at once. And, the description option can be
applied to the end of any existing descriptions,
so, for instance, for a trip to the Farmers Market,
you could enter individual descriptions for any
photos that needed special commentary (Huge
Turnips!"), but then append something like
"Farmers Market, Ithaca" to each description.
You add keywords via a different interface, but
you can still add them to multiple shots at once.
Choose Window > Show Keywords to open the
Keywords palette, select a bunch of photos, and
then click any keyword button in the palette to
apply that keyword to all selected photos. In that
same Keywords palette, you can click Edit to

manage your keywords and assign single-letter
keyboard shortcuts to them. The single letter
shortcuts are especially handy for applying
keywords quickly, since with them you can
select a bunch of photos and, as long as the
Keywords window is open, press a key to apply
its associated keyword to all the selected photos.

Flag Photos -- As you go through a bunch of
photos, you may want to single some out -
maybe you're considering them for an order of
prints or you want to show them to your spouse -
you could create a separate album, but if you are
like me, this results in your having about 20
miscellaneous albums that you aren't sure if you
need any longer. It might be better to create a
more temporary "album" that could later,
possibly, be converted to a more formal project
like a calendar or book. You can do this with the
new Flag command in iPhoto 7.

To flag selected photos, click the Flag icon in the
toolbar or press Command-Period (yes, that's an
odd keyboard shortcut for those of us who
remember it being the universal "Stop
everything!" shortcut). To view all your flagged
photos quickly, select the Flagged item in the
Source pane (in the Recent category). Now that
you've flagged photos, you can drag them from
the Flagged category to an album, or you can
make them into a new event via the Events
menu.

The screenshot shows an unflagged photo at left
and a flagged photo at right. The flagged photo
has an orange flag in its upper left corner.
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That's all for the tips, and I hope they give you
the extra productivity push to work with your
photos more meaningfully. I'll be using them to
sort through my family's photos from 2007 to
identify, title, describe, and keyword those that I
want to include in my holiday greeting card this
year - I'm already planning to use iPhoto 7's new
Year in Review card template.

TidBITS is copyright © 2008 TidBITS Publishing

Inc.

***************************************

Why Join the SBAMUG?
An Answer from the eGroup!

hanks to everyone for their help, we finally
got that pesky stuck CD out!

Here's how:
We used the paper clip to get it to start ejecting
and then used a blank CD to push on the stuck
CD when it got partially out. It went back in and
then came out all the way! The CD did not have
a label, so I didn't try the tape bit. We have since
had another CD get stuck and used the same
technique, so I suspect the problem is in the CD
electrical system.
This is why I love SBMUG!
Practical instant help!
Joan Kraus

Editor’s Note: The eGroup is always there for
you, 24 hours a day, 7 days a week, 365 days a
year! DW

What’d I Say
by Chico

ey Now!  Those people living up on the
Monterey Peninsula - aren’t you a little bit

jealous?  They have the best golf courses, from
Pacific Grove ($40) to Pebble Beach ($425), the
best aquarium and world class scenery (Asilomar
Beach and Point Lobos).  They have cool
restaurants like the historic Nepenthe.  They can
let their dogs run free on the beach.  And they
have KPIG, one of the world’s great radio
stations, which features “live free-range dj’s”.
Check it out at kpig.com; you’ll get a wide
selection of music from the blues to the Beatles
to Junior Brown and Todd Snider.  KPIG is the
successor to KFAT, now an online station
(kfat.com).

The Renaissance Person of the Month is Daniel
Lyons.  Last August, the identity of Fake Steve
Jobs was revealed by Brad Stone, a New York
Times technology correspondent.  He is, in fact,
Daniel Lyons, an editor at Forbes.  Fake Steve
blogs (fakesteve.blogspot.com) about
Apple/Silicon Valley news and rumors and is the
author of Option$: The Secret Life of Steve Jobs,

a Parody.  Option$ is about the stock options
backdating scandal at Apple.  El Jobso is
harassed by Federal prosecutors.  He knows
nothing of business matters, claims to be
mathlexic.  He spends his time meditating,
drinking tea, shopping for turtlenecks,
consuming recreational drugs, firing the
occasional employee and making prank phone
calls.  He is dismayed by Hollywood producers
and Windows users (Microtards).  He just wants
to be left alone so he can create beautiful objects.
Whenever someone fails to give him the proper
respect, he says “I invented the iPod; have you
heard of it?”  It’s hilarious.

What do you say?  If you have a favorite
website, podcast, Youtube clip or other gem or a
nominee for Renaissance Person of the Month,
please contact chico@sbamug.com.

T
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Better Surfing With Safari
By Ed, ed@Smalldog.com

hile I occasionally use Firefox, and I think

it's great, Safari is my web browser of

choice. Like most OS X applications, Safari has

many features that are not obvious. Here are my

top six:

1. Browse Safe. It is highly recommended that

Safari users disable the option of "Open safe

files" after downloading." That's because, in

theory, you could download a malware program

that might run if it opens automatically. While

this is far-fetched in reality, it's still wise to

disable the feature. It's easy to do. Launch Safari.

Browse to Preferences  > General. Un-check the

box that says "Open safe files after downloading."

Safari is a safe web browser. It uses strong 128-

bit encryption when accessing secure sites. It's

also easy to block annoying pop-up windows; to

do this, launch Safari, click on the word Safari in

the upper-left hand corner of your screen, and

choose "Block pop-up windows."

It's also very easy to hide your web browsing

history when using Safari. This is useful while

Christmas shopping online, or, say, cheating on

your spouse.

Just select "Private Browsin g" under the word

Safari in the upper-left hand corner of your

screen. No information about where you visit on

the Web, personal information you enter or pages

you visit are saved or cached. Apple says "It’s as

if you were never there."

2. Tabbed browsing. New users might not know

about this feature, because it's not enabled by

default. Tabs allow you to open multiple web

pages in a single browser window - very

convenient. To enable tabs, launch Safari, then

browse Preferences > Tabs . Enable Tabbed

Browsing. To open a link in a new tab, click

"Command - T ."

Note that the command key is the key to left of

the spacebar on most keyboards. Apple keyboards

have an Apple icon printed on the Command key.

3. Bookmark Management. I love bookmarks - in

fact, I'm probably too reliant on them.  Some of

the important websites I connect to have long,

bizarre URLS, which I don't have memorized.

Luckily, Apple makes it easy for me to export my

bookmarks so I can easily back them up. Launch

Safari, and browse to File > Export Bookmarks.

Put this file on a flash key, external hard drive, or

email them to yourself. You can also share your

bookmarks by emailing them to other people.

To add a bookmark, click the "+" symbol at the

top of Safari - or, simply click "command - D."

To organize bookmarks, click on the icon that

looks like an open book at the top left side of

Safari, or browse to Bookmarks > . Show All

Bookmarks. Here you can rename bookmarks,

create new bookmark folders (such Red Sox

Links, Work Links, Mac Links, etc.) and delete

bookmarks. You can also review your RSS feeds

here. Which brings me too...

4. RSS Feeds.  RSS is a way that websites

summarize their content for fast browsing. With

RSS, you get a list of headlines with a line or two

about each article. You can quickly see if content

on a website has been updated, before reading the

entire page. If you go to a web page in Safari and

a blue box reading "RSS" appears in the upper

right corner of the address bar, the site has an

RSS feed.

Click on the blue RSS button to see the RSS

summary. To subscribe to a website's RSS feed,

add the RSS page as a bookmark. The bookmark

will tell you when content on that page is updated

by showing the number of new items. Click on

that RSS button, and you will get to preview all

the new written content on that page - without

actually reloading it.
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Small Dog Electronics specials page has an RSS

feed. If you subscribe to it, you'll be able to keep

track of our promotions - hint, hint.

5. Keyboard Short Cuts. Like most applications

built into Tiger, Safari has lots of keyboard short

cuts. Here are a few:

- Option - mouse-click on a link to download the

linked page to your desktop.

- Ctrl-mouseclick (on laptops and Macs with a

single button mouse) or right click (on Macs with

a right-click mouse) on a link on a webpage, to

get a drop down menu with options to open  links

in new windows, open links in new tabs (if tabs

are enabled), download the linked file to your

desktop, and also to copy the link.

- Command-I to email contents of a web page by

OS X Mail

- Command-shift-D: to check spelling in a web-

form.

6. Kid-Proof the Internet. Ok, so that's not really

one of my top five favorite tips. However, many

people ask about this so I've included it. The

following comes straight from Apple:

"Start your kids’ Web exploration off on the right

foot with Safari Parental Controls. Specify

exactly which websites your children access by

bookmarking only those sites on the Safari

Bookmarks Bar. With Safari Parental Controls

enabled, your kids browse only the sites on the

Bookmarks Bar. New web addresses typed into

the address field or non-approved sites linked

from approved sites will not load on Safari.

Instead, an error message appears, giving your

child the option to request approval on blocked

pages."

Here is a great link that describes exactly how to

do this:

http://www.macwork.com/2006/05/01/parental-

control/

Note that most kids over 13 will likely be able to

figure out how to get around parental controls in

Safari.

An iPhoto 6 Slideshow With More
Than One Song?
By Ed@Smalldog.com

ecently several people asked me how to

make a slideshow with more than one song

in iPhoto 6. They could only get one song to play

over and over again during their long photo

slideshows. As a "work around," a couple of them

tried to make the slideshow in iMovie, instead of

iPhoto. It's actually fairly easy to make a

slideshow with multiple songs in iPhoto 6 -

maybe too easy!

Here's how:

1. Make a playlist in iTunes with all the music

you want to use in your iPhoto slideshow.

2. Make an album in iPhoto with all the photos

you want to feature in your slideshow.

3. Navigate to that album, and then click the

Slideshow icon at the bottom of iPhoto pane

(usually between "edit" and "card" in iPhoto 6.)

4. In the "slideshow view," click on the "music"

icon at the bottom of the iPhoto pane - it looks

like the iTunes icon.

5. In the dialogue box that pops up, click on the

"iTunes" icon. you should now be able to see all

your iTunes playlists  - including the playlist you

made in step one.

6. Select the playlist you made in step one - and

make sure the box is checked that reads "Play

music during slideshow."

7. Now you can play the slideshow with all the

songs in the playlist.

Note that you can also export your iPhoto

slideshow as a Quicktime movie that can be

played on a Mac or PC, can be uploaded to the

Internet, burned to CD, or emailed to a friend.

Highlight the slideshow in iPhoto's left pane, and

then click File > Export > Save as... Again, this is

iPhoto 6.

You can use songs purchased from the iTunes

Store in slideshows you play on your iTunes

authorized computer. However, you can't usually

export slideshows with music purchased from the

iTunes Store, unless the DRM has been removed.
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THIS MONTH’S MEETING
W e d n e s d a y  January 30, 2008  7:30PM

320 Knob Hill, Redondo Beach
(see map at left for directions)

GREAT RAFFLE PRIZES TOO, TICKETS ONLY $1 EACH!

Debbie Shadowitz Returns!
Be here Wednesday, the 30th! You’ve been waiting for this 
meting! We’re lucky to have one of our favorite speakers, 

Debbie Shadowitz, join us to share what’s been going on in 
the world of Apple.  So timely to have her visit us so soon 

after MacWorld in San Francisco! Bring a friend!

And Of Course:

Come early (6:30) for Beginners Q & A Sessions! 

We now have two: 

one in the main hall hosted by Bob Brooks & Jim Pernal 

and the other in the kitchen area hosted by LJ Palmer  

February 27th:
Stay tuned to find out what treat is in store  for you. Check 

out the postings on the eGroup and be sure to check this 
page in the February edition of the SBAMUG newsletter.

Thanks to our wonderful refreshment committee for 
keeping us supplied with goodies.

Please help out when you can.

How Much Do You Benefit
from the SBAMUG?

Can you help out by hosting a 
Core Group meeting, bringing 

some refreshments to the general 
meeting, set up, clean up, 

whatever! Please let us know.
This is a volunteer organization 

and we all need to pitch in!

We welcome 
your input!

Any comments or ideas for future 
meetings? Write it down and drop it in 
our Suggestion Box on the refreshment 
table at our monthly meetings, or speak 

to a Core Group member.

INTERNET ACCESS
Don’t forget we have wireless internet 

access at our meetings. Bring your wifi 
capable laptop with you when you show 

up for our next meeting!



!"#$%&$'()*

!"#$%& '()& *++,-&.(/& 01-2& 32"#+
!"#$"#%&'#()*
+,-&.-&#%,/012#
34#56*7786()*

9%4:;<#:,=>,?@1AB#4BBCA0/DA&.
9&ED1#%/F#4BBC,#:/0A.D&@1#;@,?#<?&EB#B?&GA-,@#:/0#&H.,?@#/.-#E@,?@#HAD1#/#C&0/C#@&E?0,#

&I#@1/?,-#J.&HC,-K,#/.-#,'B,?A,.0,#D1?&EK1#=&.D1CF#=,,DA.K@2#D?/A.A.K#@,=A./?@#
/.-#&E?#=&.D1CF#.,H@C,DD,?"

L.-AGA-E/C#/.-#I/=ACF#=,=>,?@1AB#A@#M)N#B,?#F,/?#B/F/>C,#D&#9%4:;<"
!!O,H#:,=>,?##########!!:,=>,?#+,.,H/C

O/=,P# QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
4--?,@@P### QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
3ADFP## QQQQQQQQQQQQQQQQQQQQQQQQQQQ### 9D/D,P#QQQQQQQQQ## RABP#QQQQQQQQQQQ
S&=,#!1&.,P#QQQQQQQQQQQQQQQQQQQQQ##T=/AC#4--?,@@P#QQQQQQQQQQQQQQQQQQ
9B,0A/C#3&=BED,?# L.D,?,@DP#QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
:&-,C#&I#:/0A.D&@1#U&E#;@,#:&@DP#QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
S&H#-A-#F&E#1,/?#/>&ED#9%4:;<VP#QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
3&==,.D@P# QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
QQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQQ
9AK./DE?,P#QQQQQQQQQQQQQQQQQQQQQQQQQQQ#### W/D,P#QQQQQQQQQQQQQQQQQQQQQQ

%?A.K#4BBCA0/DA&.#X#Y,,@#D&#:,,DA.K@#&?#:/AC#D&P
9%4:;<

!"$"#%&'#()*
+,-&.-&#%,/012#34##56*77


